AFM

WORKSHOP,

The LS-AFM is a tip-scanning AFM
designed specifically for life science
applications when paired with an
inverted optical microscope. The
product includes everything required
for AFM scanning: AFM Stage,
Inverted Microscope Adaptation Plate,
Ebox, Manuals, Cables, and

AFM-Control Software.

The LS-AFM may be purchased in

two different configurations.

LS-AFM-A

For customers who own an
inverted optical microscope: In
this configuration, AFMWorkshop
fabricates a special plate that pairs
the LS-AFM with the customer's

existing inverted optical microscope.

LS-AFM-B
This configuration includes the
LS-AFM and a full-featured inverted

optical microscope.

Life Sciences Atomic

Force Microscope
m [ S-AFM-B

Model ID: m LS-AFM-A

Features of the LS-AFM include:
Dry and Liquid Z Scanner

AFM Adapter Plate for Inverted Microscopes
Linearized XY Scanner

Advanced Force Distance Curves

Glass Slide and Petri Dish Sample Holder
Precision AFM Alignment System with Lock-Down
Included Modes: Vibrating, Non-Vibrating, Phase and LFM
Direct Drive Z Motor

Compatible With Standard AFM probes

Intuitive LabVIEW™ Software Interface

High Resolution Zoom Video Camera

High Resolution 24 Bit Scanning

USB Ebox Interface

Available With AFMWorkshop Inverted Microscope
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APPLICATIONS

The LS-AFM is designed for

the most widely used types of
measurements made with an AFM,
including measuring F/D curves
and imaging cells in a dry and

liguid environment.

> Cell Imaging

Images of cells are readily scanned in both a liquid and dry
environment with the LS-AFM.

Image of an E Coli cell Image of cheek cell measured
measured with the Dunk in ambient air.
and Scan probe holder.

> Imaging Cells In Combination With An Inverted Optical

Microscope

The inverted optical microscope facilitates direct placement of the
probe on an area of interest for scanning. Additionally the inverted
microscope can be operated in epiflourescence mode.

Neutrophil A Cells

Inverted optical microscope Light Shaded AFM image of
image of neutrophil A cells. the cells visualized in the
optical microscope image.

CACO-2
CACO-2 cell structure in the presence of low concentration
of quantum dots.
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Left: Epifluorescence, Right: Topographic AFM
showing brightfield image of the indicated
(red), DAPI (blue), 2.2nm area.
quantum dot PL emission
at 560nm (green).
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Monitoring the deflection of a » F/D Curves

cantilever as it is pushed against a 2 PP e R ] £ Pt .
WORKBHDR i
sample results in a force/distance (=1 @
curve. From the force distance L B
= E
curve many parameters may be
, B
measured, such as stiffness e e
= i |
of the sample and a —
Moy i Fr e
. Cawdng
probe-sample adhesion. -
In biological samples, the —e N

most common application is

measurement of intermolecular The above screen shot demonstrates Advanced Force Distance Curve

] software measuring an AFM image.
forces. For example, this could be

1. Force-Distance data display region

used to measure the interaction o . . . .
2. Slider indicates the extension of the Z piezoelectric ceramic

force between an antigen and an 3. Control parameter selection options
anhbody d”‘ectly Ce[[_ceu adhes|on 4. AFM Image for Selecting locations for force-distance
measurements

forces and cellular stiffness can

also be measured. The Force/Distance Curve Measurement Software Interface includes
all the features required for making advanced measurements. F/D
curves may be made on single or multiple points of a sample surface.
Control parameters include extend/contract rate, turn around trigger,
and number of measurements per selected region.
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Z Motor

Video Microscope

XYZ video microscope postion control
XY Translator for AFM Stage

XY Piezo Scanner

Light Lever

Sample XY position stage

Adapter Plate

AFM STAGE

The AFM Stage is secured on an
adapter plate that is attached to
the inverted optical microscope.
There is an XY translation stage
for moving the sample under the
AFM Probe. Additionally there is
an XY translation stage for moving
the AFM over the inverted optical

microscope axis.

> Sample Stage for the LS-AFM

o,
-
.

=y
o

iy -

S
}x 0

-5
g iy

» Z Scanner for Liquid Imaging

Cantilever
Glass window

Liquid

Z Piezo

Sample
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Wwy1 G10X/22

Bulb Cover I i

Phase Slide Centering Telescope  Eyepiece

Lambda Plate DIC Polalizer
L ]

LWD20X/0.40 LWDPH10X/0.25  LWDPH20X/0.40  LWDPH40X/0.80

WD 7.97 WD 9.67 WD 7.97 WD 3.76
8 & y I

5 \
Specimen Stage
C-Mount Video Port
g © e | |
Objective

DSZ Main Body

Lamp Chamber AFM stage
adapter Plate
L @@
] DIC Analyzer Stage with 2X3
UV, V. B, G excitation inch microscope
i Fluorescence Filter slide translator

INVERTED > Included Items

a. Lamp Chamber for Florescence Microscopy

M |CROSCOPE b: UV, V. B, G excitation Filters
(I_S—AFM - B ON I_Y) c. Stage with 2" X 3" microscope slide translator

d. AFM Stage Adapter Plate(supplied by AFMWorkshop)

The LS-AFM may be purchased e. Objectives
» Infinity LWD plan achromatic objective 10x/0.25 WD9.67
as an integ rated AFM/Inverted » Infinity LWD plan achromatic objective 20x/0.40 WD7.97,
» Infinity LWD plan achromatic objective 40x/0.60 WD3.76
Microscope. The Inverted » Infinity LWD plan phase contrast objective 20x/0.40 WD7.97
f. Centering Telescope

Microscope includes all the options " DIC Polarizer
. Lambda Plate
i. Bulb Cover
j. Phase Slide
k. C- mount port

. Main Body

O «Q

for Fluorescence, Phase Contrast,

and standard Illumination imaging.

» Not Shown
» Power supply for florescence lamp

» Power supply for illumination lamp

» Video Camera
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EBOX

Electronics in the LS-AFM are
constructed around industry-
standard USB data acquisition
electronics. The critical functions,
such as XY scanning, are optimized
with a 24-bit digital to analog
converter. With the analog

/ feedback loop, the highest fidelity
scanning is possible. Vibrating
mode scanning is possible

with both phase and amplitude
feedback using the high sensitivity
phase detection electronics.
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24-bit scan DAC

Scanning waveforms for generating precision motion in the XY axis
with the piezo scanners are created with 24-bit DACS driven by a
32-bit micro controller. With 24-bit scanning, the highest resolution
AFM images may be measured. Feedback control using the XY strain
gauges assures accurate tracking of the probe over the surface.

Phase and Amplitude Detector Circuit

Phase and amplitude in the Ebox are measured with highly stable
phase and amplitude chips. The system can be configured to feed
back on either phase or amplitude when scanning in vibrating mode.

Signal Accessible

At the rear of the Ebox is a 50 pin ribbon cable that gives access to all
of the primary electronic signals without having to open the Ebox.

Precision Analog Feedback

Feedback from the light lever force sensor to the Z piezoceramic is
made using a precision analog feedback circuit. The position of the
probe may be fixed in the vertical direction with a sample-and-hold
circuit.

Variable Gain High Voltage Piezo Drivers

An improved signal to noise ratio, as well as extremely small scan
ranges are possible with the variable gain high voltage piezo drivers.

Microprocessor for scan generation through 24-bit DAC's

Low noise, variable gain high voltage amplifiers with PID
feedback for XY scanning

Dimensions: Width 6” | Height 10" | Depth 14"

High fidelity, low noise Z feedback circuits for accurate
probe tracking

Phase and amplitude detection circuits for vibrating
mode AFM

Industry-standard National Instruments USB data
acquisition board

Internally accessible header for signal input/output

Eight channels of ADC for monitoring and displaying data
with LabVIEW™ software
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SO FTWAR E > Pre-scan Window

Software for acquiring images

A pre-scan window presents
users with a logical sequence
of all functions required before

is designed with the industry- nitiating a scan.

standard LabVIEW™ programming

visual interface instrument

design environment.

Functions such as setting scanning

parameters, probe approach, [ —— Once the steps in the pre-scan

y window are completed, the scan
window is used for measuring
images. Scan parameter, Z
feedback parameters, and image
view functions may be changed
with dialogs on this screen.

3

frequency tuning and real time

image display are all standard, and

included with the product.

If special enhancements are

needed, LabVIEW™'s programming

environment facilitates rapid Optional Advanced Force/

Distance software may be
purchased. This option requires a
TS-17Z Z scanner.

software development. LabVIEW™
standards ensure that the LS-AFM

can be combined with any other

instrument using LabVIEW™ VI,

> LabVIEW™ Window

LabVIEW™ is an industry-
T e R standard programming
EF!’ ) environment for controlling
== = instrumentation. All the software

Eo e cd] premg for the LS-AFM is written with
LB LabVIEW™ and can be readily
m

B customized for specialized

== am applications.

wﬁ o {8 B | Anyinstrumentation already

Lt - using LabVIEW™ can be added
to the LS-AFM to create new
capabilities.
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IMAGE ANALYSIS
SOFTWARE

Included with the LS-AFM is
Gwyddion open source SPM image
analysis software. This complete
image analysis package has all the
software functions necessary to

process, analyze and display

SPM images.
File
Edit
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Visualization: false color representation with different types of mapping

Shaded, logarithmic, gradient- and edge-detected, local contrast
representation, Canny lines

OpenGL 3D data display: false color or material representation
Easily editable color maps and OpenGL materials

Basic operations: rotation, flipping, inversion, data arithmetic, crop,
resampling

Leveling: plane leveling, profiles leveling, three-point leveling, facet
leveling, polynomial background removal, leveling along userdefined lines

Value reading, distance and angle measurement

Profiles: profile extraction, measuring distances in profile graph, profile
export

Filtering: mean, median, conservative denoise, Kuwahara, minimum,
maximum, checker pattern removal

General convolution filter with user-defined kernel

Statistical functions: Ra, RMS, projected and surface area, inclination,
histograms, 1D and 2D correlation functions, PSDF, 1D and 2D angular
distributions, Minkowski functionals, facet orientation analysis

Statistical quantities calculated from area under arbitrary mask
Row/column statistical quantities plots

ISO roughness parameter evaluation

Grains: threshold marking and un-marking, watershed marking

Grain statistics: overall and distributions of size, height, area, volume,
boundary length, bounding dimensions

Integral transforms: 2D FFT, 2D continuous wavelet transform (CWT), 2D
discrete wavelet transform (DWT), wavelet anisotropy detection

Fractal dimension analysis

Data correction: spot remove, outlier marking, scar marking, several line
correction methods (median, modus)

Removal of data under arbitrary mask using Laplace or fractal
interpolation

Automatic XY plane rotation correction
Arbitrary polynomial deformation on XY plane
1D and 2D FFT filtering

Fast scan axis drift correction

Mask editing: adding, removing or intersecting with rectangles and
ellipses, inversion, extraction, expansion, shrinking

Simple graph function fitting, critical dimension determination
Force-distance curve fitting

Axes scale calibration

Merging and immersion of images

Tip modeling, blind estimation, dilation and erosion
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VIDEO
MICROSCOPE

A video optical microscope in an AFM

Inverted optical microscope image
of Caco-2 cells in the LS-AFM.
Clearly visible is the AFM cantilever
on the right side of the image.

A box identifies the area for

serves three functions: aligning the AFM scanning.

laser onto the cantilever in the light
lever of the AFM, locating surface

features for scanning, and facilitating

probe approach. The LS-AFM includes
a high performance video optical
microscope along with a 3 megapixel
camera, light source, microscope

stand, and Windows software

for displaying images.
3-D color scale AFM image of the
area indicated with the box in the
above Caco-2 cell inverted optical
image. The scan range is

48 pm x 48 pm.

Laser alignment is greatly
facilitated with the video optical
microscope. This vibrating
cantilever is 250 ym long. The red
spot is from the laser reflecting
off the cantilever.

The video optical microscope
zooms in to show an HOPG
sample surface and the

AFM cantilever.
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PROBE HOLDER/
EXCHANGE

The LS-AFM utilizes a unique probe
holder/exchange mechanism. Probes
are held in place with a spring device

that mates with a probe

exchange tool.

. . . . Probe holder
This combination makes changing

Probe inserted in clip

probes fast and easy on the LS-AFM.

Probe exchange tool

SCANNING MODES

. Vet Fraguéncy
Standard with every LS-AFM are MY -
nonvibrating (NV) mode and vibrating e tmg  Fresncy Grla E:.:
. 23 ﬁ Horacrz o | LaweriHz) e
(V) modes for creating i o [T e 2% ‘ i
tOpOgraphyscanS. ;l 1@:— A o Uepee ) D A0 P00 2TES00 2TE000 RS0 JTT0M0 2S00 27000 |
i -u-E’ H50  um Soaps 3
Additional modes included with the geon S0 ) !
product are lateral force imaging and im
5t | TAD00 TAECO FTED00 75500 J7E000 JPEED0 000 29750 27000
phase mode imaging. ETaE R

Any scanning mode that can be With the window above the resonance frequency of a cantilever is readily
implemented with a light lever AFM is measured. Additionally, the phase characteristics of the probe-sample

possible with the LS-AFM. interaction may be captured.

INSTRUMENT
INNOVATION

As with all AFMWorkshop products,
the LS-AFM’s mechanical design
documents, schematics and software
source code are available to
customers. This information enables
customers to modify the LS-AFM and
to create new AFM instrumentation
for novel applications.
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SPECIFICATIONS

» 40 Micron XYZ Scanner
» Type
» XY Linearity
» XY Range
» XY Resolution

» XY Actuator type
» XY Sensor type
» ZRange

» Z Linearity

» Z feedback noise
» Z Actuator Type
» Z Sensor type

» Light Lever AFM Force Sensor
» Probe Types
» Probe Insertion
» Probe Exchange
» Probe Holding Mechanism

» Laser/Detector Adjustment Range
» Adjustment Resolution
» Minimum Probe to Objective
» Laser Type
» Laser Focus
» Detector
Type
Band Width
Signals Transmitted
Gain

Modified Tripod
<1%

> 40 um

< 3 nm closed loop
< 0.3 nm open loop
Piezo

Strain Gauge

>16 um

<5 %

<0.2nm

Piezo

Strain Gauge

Industry-standard
Manual

Tool

Clip

Vibrating Mode Piezo
Electrical Connector
to Probe

+/-1.5mm

1 um

25 mm

670 nm Diode, < 3 mW
<25um

4 Quadrant

> 500 kHz

TL, BL, TR, BR
Low, High Settings

p Z Motion

» Type

» Range

» Drive Type

» Min. Step Size
» Slew Rate

» Limit Switch
» Control

Analog Electronics

» Vibrating Mode
Freg Range
Output Voltage
Demod. Freq

» Z Feedback
Type
Bandwidth
Sample Hold
Voltage

» Xy Scan
Voltage
Bandwidth
Pan & Zoom

» Tip Approach Cutoff

Software

»  Environment

» Operating System
» Image Acquisition

» Control Parameters

Direct Drive

25 mm

Stepper Motor
330 nm

8 mm/minute
Top, Bottom
Software — Rate,
Step Size

2 kHz - 800 kHz
10 Vpp
TBD

PID

>3 kHz
Yes
0-150V

0-150V

> 200 Hz

22 Bits

< 20 ym sec.

LabVIEW™
Windows

Real Time Display
(2 of 8 channels)

» Probe sample angle 10° PID Yes
Setpoint Yes
> Digital Data Input Output Range Yes
» Connection UsB Scan Rate Yes
» Scanning DAC Image Rotate 0 and 90°
Number 2 » Laser Align Yes
Bits 24 » Vibrating Freq. Display Yes
Freguency 7 kHz » Force Distance Yes
» Control DAC » Tip Approach Yes
Number 2 » Oscilloscope Yes
Bits 14 » Image Store Format Industry-standard
Frequency 2 kHz » Image Pixels 16 x 16 to 1024 x 1024
» ADC » H.V. Gain Control XY and Z
Number 8 » Real Time Display Line Level,
Bits 14 Light Shaded,
Frequency 48 kHz Grey Color Palette
» Calibration System Window
» Probe Center Yes
Quantum Design
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SPECIFICATIONS cowrinven.

» Video Microscope p Stage

Field of view 2X2mm 300 X 300 um = . L ;
o o o .4 !
Working Distance 114 mm 114 mm o
L]

v il . o 3

[ — I
» Computer ey A | - -
» Industry-standard Computer & Monitor L | _ = i —
(laptop available upon request) - - -

» Windows ‘ . ‘

» AFMWorkshop LabVIEW.exe installed Back and side view of the LS-AFM stage without the AFM/
video microscope. The feet at the bottom may be removed if
the stage is rigidly mounted to a surface.

* Z Noise performance depends greatly on the environment the
LS-AFM is used in. Best Z noise performance is obtained in a
vibration-free environment. Z noise on inverted microscope is < 1 nm.
** Every effort is made to present accurate specifications within this
document. However, due to circumstances beyond the control of
AFMWorkshop, specifications are subject to change without notice.
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